Tutorial on how to install and run Java on Lego
Mindstorms EV3 using Eclipse on Windows

1. Download the Mindstorm Software
https://www.lego.com/en-us/mindstorms/downloads/download-software

You will need the USB driver for your EV3 and the easiest way to install it is to
install the complete EV3 Developer Software. This is LEGO’s own software
based on LabView. It is a graphical programming language and we

will NOT be using it. We only need the USB driver that comes with it.
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EV3 SOFTWARE DOWNLOAD (PC/MAC)

Download, install, connect and complete programming missions. For the
five Hero robots, there are up to five programming missions. You learn
how to program fun and basic features

For PC: Once the .exe file has downloaded, double-click on the file and
follow the on-screen instructions

For Mac: In the download folder you will need to double-click on the dmg
file and then double-click on the PKG file and follow the on-screen
instructions

Download for Windows Download for 0S X

Just double click on the installer to launch the process. You will not only have the easy

to use programming environment, but also all the driver installed.




Y LEGO MINDSTORMS EV3 Home Edition — X

Destination Directory min d sSTSrm g

Select the primary installation directory.

Destination Directory
C:\Program Files (x86)\LEGO Software\LEGO MINDSTORMS EV3 Home Edi| | Browse...

<< Back Nexst >> Cancel
U LEGO MINDSTORMS EV3 Home Edition - X
License Agreement .
You must accept the licenses displayed below to proceed. M min d sTerm ns,,

NI LEGO MINDSTORMS
NATIONAL INSTRUMENTS SOFTWARE LICENSE AGREEMENT

A

CAREFULLY READ THIS SOFTWARE LICENSE AGREEMENT ("AGREEMENT"). BY
DOWNLOADING THE SOFTWARE AND/OR CLICKING THE APPLICABLE BUTTON TO
COMPLETE THE INSTALLATION PROCESS, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT. IF YOU DO NOT WISH TO BECOME A PARTY TO THIS AGREEMENT AND
BE BOUND BY ITS TERMS AND CONDITIONS, DO NOT INSTALL OR USE THE SOFTWARE,
AND RETURN THE SOFTWARE (WITH ALL ACCOMPANYING WRITTEN MATERIALS AND
THEIR CONTAINERS) WITHIN THIRTY (30) DAYS OF RECEIPT. ALL RETURNS TO NI WILL BE
SUBJECT TO NI'S THEN-CURRENT RETURN POLICY. IF YOU ARE ACCEPTING THESE
TERMS ON BEHALF OF AN ENTITY, YOU AGREE THAT YOU HAVE AUTHORITY TO BIND THE
ENTITY TO THFSF TFRMS

The software to which this National Instruments license applies is LEGD MINDSTORMS EV3 Home Edition.

@I accept the above 2 License Aareement(s).

(O | do not accept all these License Agreements.

<< Back I Nexst >> I Cancel




2. Install Java
Check if you already have java installed: open command prompt by typing cmd in the
search box. And then type java —version

BN Select Command Prompt — O X

Microsoft Windows [Version 10.0.15063]
(c) 2017 Microsoft Corporation. All rights reserved.

C:\Users\roxana>java -version

java version "1.8.0_144"

Java(TM) SE Runtime Environment (build 1.8.06_144-b01)

Java HotSpot(TM) 64-Bit Server VM (build 25.144-b61, mixed mode)

C:\Users\roxana>

2.1 Download & install version 7 of the Java Development Kit (JDK)
Visit http://www.oracle.com/technetwork/java/javase/downloads/java-archive-

downloads-javase7-521261.html to download the version 7. You will need the JDK

version. Oracle did already release version 8 of Java, but not yet for the EV3 brick. To
build a proper Java project you need to build it for version 1.7. The catch is that the
latest version of Eclipse requires Java version 8, which we will download and install
next. You can have multiple version of Java installed on your computer without any

problems.




E Java Archive Downloads X

(& ‘ @ www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase7-521261.html

Java SE

Java EE

Java ME

Java SE Advanced & Suite
Java Embedded
Java DB

Web Tier

Java Card

Java TV

New to Java
Community

Java Magazine

[ Overview ‘ Downloads l Documentation H Community H Technologies H Training

Java SE 7 Archive Downloads
Go to the Oracle Java Archive page.

Thank you for downloading this release of the Java™™ Platform, Standard Edition Development Kit

(JDK™). The JDK is a development environment for building applets, and ¢ t
using the Java programming language.

The JDK includes tools useful for ping and testing prog|
language and running on the Java™ platform.

written in the Java programming

WARNING: These older versions of the JRE and JDK are provided to help developers debug issues
in older systems. They are not updated with the latest security paiches and are not recommended for
use in production

For production use Oracle recommends downloading the latest JOK and JRE versions and allowing
auto-update.

Only developers and Enterprise ini should these

Downloading these releases requires an oracle.com account. If you don't have an oracle.com
account you can use the links on the top of this page to learn more about it and register for one for
free.

For current Java releases, please consult the Oracle Software Download page.

For more information on the transition of products from the legacy Sun download system to the
Oracle Technology Network, visit the SDLC Decommission page announcement.

Java SE Development Kit 7u80

You must accept the Oracle Binary Code License Agreement for Java SE to download
this software.

" Accept License Agreement ® Decline License Agreement

Product / File Description | File Size | Download
Linux %86 130.44MB & jdk-7u80-linux-i586.rpm
Linux x86 14768 MB ¥ jdk-7u80-linux-i586.tar.gz
Linux x64 131.69MB ¥ jdk-7u80-linux-x64.rpm
Linux x64 146.42 MB jdk-7u80-linux-x64.tar.gz
Mac OS X x64 196.94 MB ¥ jdk-7u80-macosx-x64.dmg
Solaris x86 (SVR4 package) 140.77MB & jdk-7u80-solaris-i586.tar.Z
Solaris x86 96.41MB ¥ jdk-7u80-solaris-i586.tar.gz
Solaris x64 (SVR4 package) 2472MB ¥ jdk-7u80-solaris-x64.tar.Z
Solaris x64 16.38 MB

# jdk-7u80-solaris-x64.tar.gz

Solaris SPARC (SVR4 package) 140.03MB ¥ jdk-7u80-solaris-sparc.tar.Z

Solaris SPARC 99.47 MB jdk-7u80-solaris-sparc.tar.gz
Solaris SPARC 64-bit (SVR4 package) 24.05 MB jdk-7u80-solaris-sparcv9.tar.Z
Soiseconinssies R - -
Windows x86 13835MB ¥ jdk-7u80-windows-i586.exe
Windows x64 140.00 MB ¥ jdk-7u80-windows-x64.exe
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ﬁ Java SE Development Kit 7 Update 80 (64-bit) - Setup X

ORACLE

Welcome to the Installation Wizard for Java SE Development Kit 7 Update 80

This wizard will guide you through the installation process for the Java SE Development
Kit 7 Update 80.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

f,‘ Java Setup - Destination Folder X

ORACLE

Install to:
C:\Program Files\Java\jre7\ Change...




2.2 Download & install version 8 of the Java Development Kit

(JDK) for Eclipse
You can skip this step if you already have java 8 (1.8) installed.

http://www.oracle.com/technetwork/java/javase/downloads/index.html

e . O X
E Java SE - Downloads | C1 X
& C ‘@ www.oracle.com/technetwork/java/javase/downloads/index.html Y| ¢
—
ORACLE _— Menu Q ‘.. Account v

Downloads

Oracle Technology Network > Java > Java SE >

Java SE \ Overview ‘ Downloads \ Documentation H Community H Technologies H Training
Java EE

Java ME Java SE Downloads

Java SE Advanced & Suite N

Java Embedded | / :

Java DB (_“"i’) lava_ @ Nﬂmﬂns
Web Tier —

Java Card |
oy [ oowniono s |
New to Java Java Platiorm (JDK) 8u144 NetBeans with JDK 8

Community |

Java Platform, Standard Edition |

Java Magazine
Java SE 8u144
Java SE 8u144 includes important bug fixes. Oracle strongly recommends that all Java SE 8
users upgrade to this release.
Learn more »

Installation Instructions JDK

DOWNLOAD #
= Release Notes _

= Oracle License

= Java SE Products server JRE
« Third Party Licenses
« Certified System Configurations

= Readme Files
JRE

= JDK ReadMe

= JRE ReadMe




e - o X
E Java SE Development Kit X
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c ‘@ www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html Y| @

ORACLE —— Menu Q S Accountv

Oracle Technology Network > Java > Java SE > Downloads

Java SE \ Overview ‘ Downloads \ Documentation H Community H Technologies H Training
Java EE
Java ME Java SE Development Kit 8 Downloads
Java SE Advanced & Suite Thank you for downloading this release of the Java™ Platform, Standard Edition Development Kit
Java Embedded (JDK™). The JDK is a development environment for building applications, applets, and components
using the Java programming language.
Java DB
Web Ti The JDK includes tools useful for developing and testing programs written in the Java programming
€0 ier language and running on the Java platiorm.
Java Card
See also:
Java TV « Java Developer Newsletter: From your Oracle account, select Subscriptions, expand
New to Java Technology, and subscribe to Java.
Community « Java Developer Day hands-on workshops (free) and other events
Java Magazine = Java Magazine
JDK 8u144 checksum

Java SE Development Kit 8u144

You must accept the Oracle Binary Code Limse Agreement for Java SE to download this
SO re.

' Accept License Agreement ' Decline License Agreement

Product / File Description File Size Download
Linux ARM 32 Hard Float ABI 77.89 MB  #jdk-Su144-linux-arm32-vfp-hfit.tar.gz
Linux ARM 64 Hard Float ABI 7483 MB  #jdk-8u144-linux-arm64-vip-hfit tar.gz
Linux x86 164.65 MB  #jdk-8u144-linux-i586.rpm
Linux x86 179.44 MB  #jdk-Su144-linux-i586.tar.gz
Linux x64 162.1 MB  #jdk-8u144-linux-x64.rpm
Linux x64 176.92 MB  #jdk-Su144-linux-x64 tar.gz
Mac OS X 226.6 MB #jdk-Su144-macosx-x64.dmg
Solaris SPARC 64-bit 139.87 MB  #jdk-Su144-solaris-sparcv9.tar.Z
Solaris SPARC 64-bit 99.18 MB  #jdk-8u144-solaris-sparcv9.tar.gz
Solaris x64 140.51 MB  #jdk-Su144-solaris-x64.tar.Z

Windows x86 190:94 MB Ejdk—8u144—v¢indows—i5§6..exe
Windows x64 197.78 MB  #jdk-Su144-windows-x64.exe




ﬁ Java SE Development Kit 8 Update 144 (64-bit) - Setup X

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 144

This wizard will guide you through the installation process for the Java SE Development
Kit 8 Update 144.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

| Next> || cancel

ﬁ Java SE Development Kit 8 Update 144 (64-bit) - Setup X

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 144

This wizard will guide you through the installation process for the Java SE Development
Kit 8 Update 144.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

[ nNext> || cancel




Java Setup - Destination Folder — X

Destination Folder

Click "Change" to install Java to a different folder.

Install to: Change...
C:\Program Files\Java\jre1.8.0_144

< Back [ Next =

3. Install LeJOS

The heart of any EV3 Java project is LeJOS. Let's install it on your computer

3.1 Download LeJOS

Visit https://sourceforge.net/projects/ev3.lejos.p/files/ to download the latest

version of LeJOS. Once the download is complete run the file.




) Setup - 1eJOSEV3 - X

LEJOS Welcome to the leJOS EV3 Setup
® | javaforLEGO Mindstorms Wizard
This will install leJOS EV3 0.9. 1-beta on your computer.

Itis recommended that you dose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

Next > I\ Cancel

) Setup - leJOS EV3 - X

Select a Java Development Kit
Select a Java Development Kit for use with leJOS EV3 2

Select the root directory of a Java Development Kit
for use with leJOS EV3: Dowsload 10K ‘

> Intel A
> Internet Explorer

v Java
(> jdk1.7.0.80 )

> jdk1.8.0_144

> jre1.8.0_144

> jre?
> Killer Networking
> Microsoft Silverlight
> Microsoft SQL Server

Aimemrnft iriial Chiudin 1NN

| <Back | Next> | | cancel |

Chose JDK 1.7 as the development kit for le]JOS EV3, as it is the recommended
version for this release.



) Setup - 1eJOSEV3 = X
Select Destination Location
Where should leJOS EV3 be installed? B

Setup will install leJOS EV3 into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

({E: Program FilesVeJOS EV3 | Browse... |

This location is important in the configuration of Eclipse

At least 40.7 MB of free disk space is required.

<Back || Next> | | cancel

) Setup - 1eJOSEV3 - X
Select Components
Which components should be installed? L]

Select the components you want to install; clear the components you do not want to
install. Click Next when you are ready to continue.

Custom installation v
leJOS EV3 Development Kit 39.6 MB
Documentation 12.6 MB
. [4] AP Documentation (EV3) 12.6 MB
.. [4] API Documentation (PC)
. [] Sample and Example Projects 0.2MB
[] Sources of leJOS EV3 Development Kit 3.8MB

Current selection requires at least 57.2 MB of disk space.

<Bak | Next> | | cancel




) Setup - 1eJOSEV3 — X
Select the Folders for the Additional Sources
Where should the additional sources be stored? B

Select the Folders for the Additional Sources:

Sample and Example Projects

I :\Users\roxana\Documents\LeJOS EV3 Samples | \ Browse... ‘
Sources of le]JOS Development Kit

|C:\Users\roxana\DommenS\LeJOS EV3 Development Kit Sources | [ Browse... }
Note:

You have selected to install the leJOS Development Kit Sources. They are not
required for developing Java programs that run the EV3 or Java programs that
remote-control the EV3. Instead, they are intended for developers who plan to take
a look at how leJOS itself works or plan on modifying parts of leJOS.

| <Back [ Next> | | cancel

) Setup - 1eJOSEV3 — X
Select Start Menu Folder
Where should Setup place the program's shortcuts? B

v
Setup will create the program’s shortcuts in the following Start Menu folder.
[

To continue, dick Next. If you would like to select a different folder, dick Browse.

Jledos V3l | | Browse...

[Jpon't create a Start Menu folder

<Back || Next> | | Ccancel




) Setup - 1eJOSEV3 - X
Ready to Install
Setup is now ready to begin installing leJOS EV3 on your computer. B

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: A
C:\Program Files\leJOS EV3
C:\Users\roxana\Documents\LeJOS EV3 Samples
C:\Users\roxana\Documents\LeJOS EV3 Development Kit Sources

Start Menu folder:
leJOS EV3

Setup type:
Custom installation

Selected components:
leJOS EV3 Development Kit v

<Back || Instal | | cancel

) Setup - leJOS EV3 - X

Installing
Please wait while Setup installs leJOS EV3 on your computer. 2

Extracting files...
C:\...\dbusjava\src\org\freedesktop\dbus\types\DBusListType.java




] Setup - 1eJOSEV3 —

LEJOS Completing the leJOS EV3 Setup
® || Java for LEGO Mindstoms  Wizard
Setup has finished installing leJOS EV3 on your computer. The
application may be launched by selecting the installed icons.

See the leJOS Wiki for how to install the Edlipse plugin and
develop programs.

Insert your SD card into the SD card reader and dick Finish to
exit Setup and run the EV3SDCard utility.

Launch EV3SDCard utility

Finish I

4. Install Eclipse IDE

The Eclipse Integrated Development Environment is a great software editor for your

Java projects. It is free and open source.

4.1 Download the Eclipse IDE
Go to https://www.eclipse.org/downloads/ and download the Eclipse Oxygen

version

&« C | @ Secure | https;//www.eclipse.org/downloads,

GETTING STARTED ~ MEMBERS ~ PROJECTS ~ MORE~

Download Eclipse Technology that is
right for you

Register now for EclipseCon Europe | October 24 - 26, 2017 | Ludwigsburg, Germany REGISTER TODAY!

Get Eclipse OXYGEN Ecan e Orjol

) .
Install your favorite Eclipse packages. Eclipse Che is a developer A modern, open source
e e e workspace server and software development
cloud IDE. environment that runs in
the cloud,




eclipseinstaller sy oompn =
| Q

ﬁ Eclipse IDE for Java EE Developers

Tools for Java developers creating Java EE and Web applications, including a Java
IDE, tools for Java EE, JPA, JSF, Mylyn, EGit and others.

C Eclipse IDE for C/C++ Developers
T

An IDE for C/C++ developers with Mylyn integration.

The essential tools for any JavaScript developer, including JavaScript, HTML, CSS,
XML languages support, Git client, and Mylyn.

9 Eclipse IDE for JavaScript and Web Developers
% Eclipse IDE for PHP Developers

The essential tools for any PHP developer, including PHP language support, Git
client, Mylyn and editors for JavaScript, HTML, CSS and XML.

L,

edclipseinstaller sy oompn

The essential tools for any Java developer, including a Java IDE, a Git client, XML

@ Eclipse IDE for Java Developers
Editor, Mylyn, Maven and Gradle integration.

Installation Folder

&/ create start menu entry

«/ create desktop shortcut

£ BACK



eclipseinstaller sy oompn -4

The essential tools for any Java developer, including a Java IDE, a Git client, XML
Editor, Mylyn, Maven and Gradle integration.

@ Eclipse IDE for Java Developers

Installation Folder  C:\Users\roxana\eclipse\java-oxygen

&/ create start menu entry

&/ create desktop shortcut

® Cancel Installation

BACK

Installation completed successfully.

@ Eclipse IDE for Java Developers

The essential tools for any Java developer, including a Java IDE, a Git client, XML
Editor, Mylyn, Maven and Gradle integration.

Installation Folder  C:\Users\roxana\eclipse\java-oxygen

&/ create start menu entry

&/ create desktop shortcut

show readme file

open in system explorer

keep installer

£ BACK



£ eclipse-workspace - Eclipse

File
&
a]

Edit Navigate

@ Welcome

Search Project Run Window Help

Review the IDE's most fiercely contested
preferences

A guided walkthrough to create the famous Hello
World in Eclipse

Create a new Java Eclipse project

Checkout Eclipse projects hosted in a Git repository

Import existing Eclipse projects from the filesystem
or archive

Enhance your IDE with additional plugins and install
your Marketplace favorites

Get an overview of the features

Go through tutorials

Try out the samples

Find out what is new

@Always show Welcome at start up v




5. Configure Eclipse
You will find the Eclipse Marketplace in the Help Menu.
Enter "lejos" in the search field and then click on install in the EV3 Plugin.

S Eclipse Marketplace [m] X

Eclipse Marketplace

Select solutions to install. Press Install Now to proceed with installation.
Press the "more info" link to learn more about a solution.

Search Recent Popular Favorites Installed ', Eclipse Newsletter (August) Exciting Ne...

Find: All Markets | | All Categories v

leJOS EV3 Plug-In
Java An Eclipse plug-in for leJOS EV3 more info

m | for by ThelelOS Team, GPL
LEGO

[ %1 | [ installs: 7.99K (412 last month)

leJOS NXJ Plug-In
J Java The 1eJOS NXJ Plug-in for Eclipse allows you to develop Java programs that on
|

for the LEGO Mindstorms NXT itself or that remove-control the NXT from the PC
LEGO Via.. more info

by The 1eJOS Team, GPL

w2 # | Installs: 7.57K (63 last month) Install

Marketplaces

= e

@ < Back Install Now > Finish Cancel

Select "l accept the terms of the license agreement” and click on Finish.
You will be asked to restart eclipse.



After Eclipse restarts you need to enter the Preferences, which are available

under the Window Menu.

S eclipse-workspace - Eclipse

File Edit Navigate Search Project leJOSEV3 Run
(€9 Welcome 52 New Window
Editor

eC| ipse Welco Appearance

Show View

]

a)

Perspective

Navigation

Review the IDE's most fiercely contested
preferences

World in Eclipse

Create a new Java Eclipse project

or archive

3

your Marketplace favorites

| Preferences

- A guided walkthrough to create the famous Hello

Checkout Eclipse projects hosted in a Git repository

Import existing Eclipse projects from the filesystem

Enhance your IDE with additional plugins and install

Get an overview of the features
Go through tutorials

Try out the samples

Find out what is new
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Set the EV3_HOME

First, you need to select the "leJOS EV3" tab on the left before clicking on
"Browse" to select the directory in which you installed LeJOS. Click on "Apply"
to complete the setup.

& eclipse-work e - Eclif — m]
£ Preferences [m] X
File Edit Navigate Search Pi
5 (€ Welcome 52 type filter text 1eJOS EV3 Ovihvyw
» G |
a’ A::era Preferences for 1eJOS EV3
» Code Recommenders EV3_HOME: IC:\Program Files\leJOS EV3 I Browse... | > |
Gradle Run Tools in separate JVM Workbench
» Help
Use ssh and
. Install/Update [JUsessh and scp o
) Defaults for run configurations:
> Java
leJOS EV3 [] Connect to named brick Name
Dc > Maven
> S IR
Rey ~ Y Defaults for run mode
pre{ ” Oomph
> Run/Debug Run program after upload
» Team
[‘:_'.]..] Cr Validation
- ad XML
Wol
Cre|
0 Ch Restore Defaults I Apply I

Chg

@ Apply and Close Cancel

¥ Import existing projects
[ ] . -
Import existing Eclipse projects from the filesystem
or archive
’ h the Ec ":'H'f\f""ﬂ"
¢ Enhance your IDE with additional plugins and install

your Marketplace favorites
V] Always show Welcome at statup v



Setup the different versions of Java
While you are in the Preferences, go to the "Java" tab and then on the
"Installed JREs". Use the "Add" button to add any missing JREs to the list.
Setup Version 7 as the default, since you will be building your EV3 programs
towards that target.

>
>
>

VvV V V Vv VvV

£ Preferences

:typefilter text

General
Ant
Code Recommenders
Gradle
Help
Install/Update
Java

> Appearance

> Build Path
Code Coverage
Code Style
Compiler
Debug
Editor
Installed JREs

Execution Environm

JUnit
Properties Files Editor
leJOS EV3
Maven

PERVIRVIRVIRY:

Mylyn
Oomph
Run/Debug
Team
Validation
XML

Installed JREs

a X

Qv v w

Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path
of newly created Java projects.

Installed JREs:

Name
=\ jre1.8.0_14...

Location

C:\Program Files\Java\jre1.8.0_... Standar¢

Type

Add...
Edit...
Duplicate...
Remove

Search...

Apply

@ ®

Apply and Close »

Cancel




File Edit

Search

Navigate
E @ Welcome 12

a.l

i

P

Ch
Che

1
Img
oré

La
Enh

S Pr nces O
type filter text I lled JREs Pvyovw =
> General . — - -
A Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path
> Ant of newly created Java projects.
> Code Recommenders
Gradle Installed JREs:
> Help .
Add...
S Install/Update Name Location Type
v Java [] =i\ jre1.8.0_14.. C\Program Files\Java\jre1.8.0_.. Standar( Edit...
> Appearance
> Build Path © AddJRE = X
Code Coverage JRE Definition
> Code Style . i %
> Compiler Specify attributes for a JRE
> Debug
> Editor JRE home: [ c:\Program Files\ava\jdk1.7.0_80 | [ pirectory... |
v Installed JREs
Execution Environm JRE name: | jdk1.7.0_80 |
JUnit =
Properties Files Editor Default VM arguments: I ‘ Variables... ‘
leJOS EV3 JRE system libraries:
> Maven > e C:\Program Files\Java\jdk1.7.0_80\jre\lib\resources.jar A Add External JARs...
> Mylyn > (3@ C:\Program Files\Java\jdk1.7.0_80\jre\lib\rt jar -
> Oomph > (b C:\Program Files\Java\jdk1.7.0_80\jre\lib\jsse jar Javadoc Location...
> Run/Debu C " . R
9 > D,;T C:\Program F!Ies\Java\J'dH.7.0_80\!re\lrb\1ce4ar ) Source Attachment..
> Team > (s C:\Program Files\Java\jdk1.7.0_80\jre\lib\charsets.jar
Validation > (i C:\Program Files\Java\jdk1.7.0_80\jre\lib\jfr.jar T
> XML > fas C:\Program Files\Java\jdk1.7.0_80\jre\lib\ext\access-bri
< > (@8 C:\Program Files\Java\jdk1.7.0_80\jre\lib\ext\dnsns.jar Remove
5> fw C:\Program Files\Java\jdk1.7.0_80\jre\lib\ext\jaccess.jar U
> fes C:\Program Files\Java\jdk1.7.0_80\jre\lib\ext\localedata :
> (e C:\Program Files\Java\jdk1.7.0_80\jre\lib\ext\sunec jar Down
< > > [ws C:\Program Files\Java\jdk1.7.0_80\jré\lib\ext\sunjce_prc ¥
< > Restore Default

®®

your Marketplace favorites

®

< Back Next >

=




S Preferences

I

> Code Recommenders
Gradle
> Help
> Install/Update
v Java
> Appearance
> Build Path
Code Coverage
Code Style
Compiler
Debug
Editor
Installed JREs
JUnit
Properties Files Editc
leJOSEV3
Maven
Mylyn
Oomph
Run/Debug
Team
Validation
> XML

Vv VViVYy

v vVVvVviVvy

~

/1, The selected JRE does not support the current compiler compliance level of 1.8

L -
(=10 A= 2 4

Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path of newly

created Java projects.

Installed JREs:
_Name Location Type I Add... ‘
[ =)jdk1.7.0_80 ... C:\Program Files\Java\jdk1.7.0... Standard ... Edit
T[T &0jrel.8.0_148  C:\Program Files\Javayjrel.6.0_144 Standard VM
O =hjre7 C:\Program Files\Java\jre7 Standard VM Duplicate...
Remove

Conflicting compliance settings can be changed on the Compiler page.

Apply

®®

IAppIy and Closel ’

Cancel ‘




